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Perfecting Piping and Duct Systems for Revit
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Learning Objectives

e Learn comprehensive steps for controlling project system settings, including
mechanical and piping system project settings

e Understand how to create the target and source relationship between equipment
without routing a duct or pipe

e Learn how to capitalize on the system sizing and analysis tools, and learn how to
maximize project performance when you don't need these features

e Learn how to improve the quality of your construction documents by capitalizing on
system-based features

Description

Revit software systems help us to define the MEP (mechanical, electrical, and plumbing) design
in several ways, but the main purpose is to understand the relationships between system
equipment, such as air terminals to air-handling units, or from a pump through a pipe. This
hands-on lab will teach you the comprehensive steps needed for controlling project system
settings, and then it will demonstrate how to capitalize on (or disable) sizing and analysis tools
related to the system. We’'ll cover creating the target-source relationship between parts, and
then we’ll review using the systems to improve the quality of your documentation. On top of this,
you’ll get a project template that already defines everything in the class, so you can take
advantage of these topics right away. The class will cover HVAC (heating, ventilating, and air
conditioning) and piping items.

Your AU Expert

David Butts is an Autodesk Expert Elite Team member and Building Information Modeling (BIM)
specialist for Gannett Fleming with over 30 years of experience in the architecture, engineering,
and construction field. He is responsible for implementation, training, BIM project support, and
management for engineering design applications, including Revit, AutoCAD P&ID, AutoCAD
MEP, Navisworks, and more. He was an Autodesk Authorized Training Center (ATC) training
manager and application engineer for an Autodesk Reseller for 13 years, providing
implementation and training services across the United States, and serving as a subject matter
expert for Autodesk, Inc.’s, Building Design Solutions. He has design experience for a variety of
project types, and is an Autodesk University top-rated speaker for labs and lectures. He authors
training videos for 4D Technologies, and he presents BIM topics for other industry associations
annually.
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Perfecting the System for Revit

When you are designing a project, there’s a big difference in how you approach your work in
CAD project versus a BIM project. In BIM there are tasks you have to complete that never came
up in a 2D project, but then there was a high likelihood of signals getting crossed, and systems
being incorrectly defined. Revit’'s system and circuit tools, which have been around since the
beginning of the MEP tools, continue to be refined and improved. That is the focus of this
session, and hopefully you will take away some information to help you leverage the benefits for
these tools.

The System Rules and the Four Step Process

The methods used by engineers and designers to create HVAC, plumbing, piping and electrical
systems has not changed since the days of hand drawing, other than the improvements to
equipment. The work process follows a straightforward approach, where the building
requirements are assessed first. The necessary equipment types are selected and located, and
then the connecting components, such as duct, pipe and wiring are added.

Once these are added, critical data and directions are provided in the construction documents in
the form of specifications, schedules, and annotations on drawings that identify and label the
components. While there are occasional points where you step outside of the process (such as
locating critical duct/pipe items in a chase), the process stays the same.

Using Revit for MEP design works best when you implement a four-step process that emulates
this approach. By following the same repeatable process, you can get more efficient at
completing our projects on time and under budget. The primary steps are:

Select and Locate Equipment — the targets and sources that define a system;

o Define and Refine the System — creating the system that connects the equipment
together;

e Connecting Geometry — adding the ducts, pipe, conduit, cable tray and wire;
Annotating the Model — adding tags, schedules and other annotations in views for the
construction documents.

The logic in this approach is to create a consistent method of approaching work. The second
step, defining the system, is a task they typically is not accounted for in most projects budgets,
since it was not required for plain AutoCAD or AutoCAD MEP.

The system is what links the sources, which are the end-of-line equipment that provide air, fluid
and power to the targets. The targets include items such as air terminals, motors, sinks, and
more, and are what is used to define the system. These items are usually placed at the same
time as the primary equipment, after the overall assessment of the building needs are
determined.

When you are defining systems, there are few key items you need to review prior to adding
anything to a model.
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Always start from a template. The template can be discipline specific, but Revit works
best when all MEP disciplines are defined within a single model. While this obviously
can’t occur when the disciplines are divided up between firms, internal projects should
follow this workflow. Systems cannot be directly connected across linked files, and
require a connector element to be added when the disciplines are separated.

While you do not want to overload your project template with every single family that can
be used on a project, it should include key families that require predefined type marks,
such as light fixtures, air terminals and receptacles. Traditional construction documents
label these items by type mark, which is a default parameter in Revit. Since the type
mark can only be defined after the family is loaded into the project, get these loaded first.
The template should also include predefined system types. Based on predefined
classifications, such as HVAC supply air and plumbing domestic cold water, the system
types allow you to create more specialized systems.

The Target always defines the system, and in order for sizing to be used, you need to
have a Source — but a source is not required to define a system.

NOTE: IMAGES IN THIS DOCUMENT MAY INCLUDE RIBBON TABS THAT APPEAR SLIGHTLY DIFFERENT FROM THE
SHIPPING VERSION OF REVIT. PLEASE REFER TO THE TEXT INSTRUCTIONS FOR REFERENCES TO THE DEFAULT
INTERFACE LOCATIONS.

Defining Project System Settings

When you start from a template, you can include predefined settings that apply to the most
common project types. Behind the scenes, there are common project tools that impact how
duct, pipe, circuiting and more are defined in the project model, so it is a logical place to start
when working with systems.

From the Manage tab, settings panel, click MEP Settings:

%

& Fabrication Settings
=L
Load Classifications

ol Demand Factors
;J Building/Space Type Settings

fEI) P&ID Settings

MEP | Panel Schedule  Additi
Settings Templates Settir
(ﬁ' Mechanical Settings
E Electrical Settings
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MEP Settings include tools that control project specific settings. These can be defined in your
project template, and edited in a project after it's started. We’re focusing on mechanical and
electrical systems, so let’s start by examining these values.

Mechanical settings control duct and pipe settings, including:

Mechanical Settings

Setting Value
=l Duct Seffings Draw MEP Hidden Lines
Angles Line Style MEP Hidden
Conversion . e
Rectanguiar Inside Gap 1/64
Oval Outside Gap 1/64"
Found Single Line 1/64"
Calculation
= Pipe Settings

Angles
Conversion
Segmerts and Sizes
Fluids
Slopes
Calculation

o Hidden Line settings for crossed duct and pipe objects;

e Duct and Pipe settings for annotations, and for project wide sizing tools;

e Angle settings that are applied to duct and pipe fittings

o Duct and pipe default materials and elevations, based on system classifications

o Predefined sizes based on duct shapes, and pipe materials, including inside/outside

dimensions
e Calculation methods used for duct and pipe sizing
¢ Pipe specific settings for fluid data and predefined slope values.

All of these settings are global to the project; in other words, changing values here
affects all examples of objects, except where object specific overrides are defined.

Defining System Types

Beyond the overall project settings, each class of items include specific settings. Revit begins
with system classifications, which are used to control duct and piping systems. These are hard-
coded items that are associated with the formulas for deriving duct and pipe sizes. While you
cannot edit the system classifications, you can edit the system types using the Project Browser.
Examples of system types would include domestic cold water supply, hot water return, makeup
supply air and more. These should be defined in your template, so the user has a starting point
for their systems.

For all system types, you must have a corresponding connector defined in the target and source
family. Duct and pipe do not have to be added to create a relationship between the target and
source, but the connectors must use the same type and/or system classification.
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Duct System Characteristics

From the Project Browser, expand the Families section. Expand Duct Systems, and select
Supply Air:

B Duct Systems

= Duct System
Exhaust Air
Return Air
Supply Air

You can edit system types by double-clicking the name, or by using the right click option to
open a menu and selecting Type Properties.

Type Properties

Family: System Family: Duct System A

Type: Supply Air

Type Parameters

Load...
Duplicate. ..

Rename...

Parameter

Value

Graphics
Graphic Overrides

Edit...

>

Materials and Finishes
Material

{<By Category>

3y [

Mechanical

Calculations

All

3y

Systern Classification

Supply Air

Identity Data
Type Image

x>

Abbreviation

Type Comments

URL

Description

Rise / Drop
Rise / Drop Symbeol

‘Cross

B -

A duct system controls the following items:

Apply

Graphic Overrides — assigned a color, linetype and hatch pattern to the duct and duct
fittings, when the system type is selected;
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o Material — assigns the material applied to the duct which controls the color and rendered
surface when using shaded or realistic views;

e Calculations — controls whether calculations are performed as the duct is placed, and
attached to target/source equipment. You can choose between All, Flow Only, None and
Performance

o System Classification — default setting that controls the calculation method, based on
the type of system, such as supply or return air;

o Type Image — location and image file used in a legend to describe the type — note that
the raster image used must be in a location that is accessible to all team members, so
it's best to place these with the project

e Abbreviation — used to label the system, such as SUPP for supply air duct
Type Comments — comments that are specific to all examples of the duct system

¢ URL - hyperlink to a website or file, such as a specification for the duct material used for
this system

o Description — text value that can be used in a tag or schedule to expand information
that might be included with an abbreviation

o Rise / Drop Symbol — displayed on a vertical section of duct, that indicates the type of
duct system

Pipe System Characteristics

Piping systems are also defined in your project template. From the Project Browser, expand
the Families section. Expand Pipe Systems, and select Domestic Cold Water:

= Piping Systems
- Piping System

Domestic Hot Water
Fire Protection Dry
Fire Protection Other
Fire Protection Pre-Action
Fire Protection Wet
Hydronic Return
Hydronic Supply
Other
Sanitary
Vent

You can edit system types by double-clicking the name, or by using the right click option to
open a menu and selecting Type Properties.
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Type Properties
Family: |Systa1'| Family: Piping System '*-"'| | Load...
Type: Domestic Cold Water v | Duplicate.
| Rename..
Type Parameters
Parameter Value

Graphic Overrides

Material -<By Category>
Mechamicll 8

Calculations All

Systemn Classification Domestic Cold Water

Fluid Type Water

Fluid Ternperature 80 °F

Fluid Dynamic Viscosity 1.1211 cP

Fluid Density 62.360000 Ib/ft*

Flow Conversion Method

Predominantly Flush Vahees

Type Image

Abbreviation

Type Comments

URL

Description

Two Line Drop Symbol ¥in Yang

Two Line Rise Symbol Outline

Single Line Drop Symbol Bend - 4 Circle

Single Line Rise Symbal Cutline

Single Line Tee Up Symbol Cutline

Single Line Tee Down Symbaol Tee - Half Circle

o ] cond [ e

A pipe system controls the following items:

Graphic Overrides — assigned a color, linetype and hatch pattern to the pipe and pipe
fittings, when the system type is selected;
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o Material — assigns the material applied to the pipe which controls the color and rendered
surface when using shaded or realistic views;

e Calculations — controls whether calculations are performed as the pipe is placed, and
attached to target/source equipment. You can choose between All, Flow Only, None and
Performance. The options will vary based on the type of system — for example, Sanitary
does not include an All option, while Other is for non-calculated systems, such as
Compressed Air.

o System Classification — default setting that controls the calculation method, based on
the type of system, such as domestic cold water, sanitary and hydronic supply.

o Fluid Type and Fluid Temperature — these options only appear with water and glycol
pressurized systems. This includes domestic water and hydronic systems.

e Fluid Dynamic Viscosity and Fluid Density — these settings are determine by the
project fluid settings, and controlled by the temperature assigned to the system. Editing
the temperature and fluid type will change these settings.

e Flow Conversion Method — these settings appear as part of the domestic water
systems, allowing you to choose between flush valve and flush tank systems.

¢ Type Image — location and image file used in a legend to describe the type — note that
the raster image used must be in a location that is accessible to all team members, so
it's best to place these with the project
Abbreviation — used to label the system, such as DHW for domestic hot water

¢ Type Comments — comments that are specific to all examples of the pipe system
URL - hyperlink to a website or file, such as a specification for the pipe material used for
this system

o Description — text value that can be used in a tag or schedule to expand information
that might be included with an abbreviation

o Rise / Drop Symbols — displayed on a vertical section of pipe that indicates the type of
pipe system, based on single line, two line and tee up/down locations on a pipe.

Creating the Target Source Relationship

MEP systems in Revit boil down to a simple task. A relationship, which is defined by a target, is
established be creating a connection to a source. In traditional CAD documentation, it's
demonstrated by following the routing of duct or pipe between these items. But after the building
is finished, after the slab is poured, the ceilings and wall finishes in place, and the roof topping
the building how, most of these items remain invisible to the occupant.

In Revit, they’re never invisible. This relationship can be made by either routing the duct and
pipe or by simply using the system tools to create it. There are several key advantages for using
the system tools first:

o The best indicator is the tab selection tool, which allows the user to place their cursor
over a device, tap the tab key, and see the structure of the system.

o The system can be used for simple layouts, based on preset preferences for materials
and routing elevations.
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e The system can also be used to control visibility properties throughout a project,
based on system type settings or view filters.

e You can select several targets at once and use them to define a system — for example,
selecting several air terminals that will all belong to the same system saves several
steps.

o The system tracks the load data from the target devices back to the sources, exposing

overall system data. But a source is not always required...wait...what? We’ll come back
to this....

Defining the System by Target

To create a system in Revit, select any one of these devices:

Modty | Bir Terminals
=) 7 &
& 3¢ &S
Edit Connect Air Terminal Duct

Family
Mode

into on Duct
Layout Create Systems

Fabrication

TARGET: AIR TERMINAL — DUCT SYSTEM

R GaRNoH I GHRERRGRRGH] iy e Errrt |

= ® @&
Edit Connect | Power Piping
Family Into
Mode | Fabrication | Layout | Create Systems
B
112"
460 W Qmt

1567 WA

Motar

TARGET: PUMP — POWER SYSTEM/PIPING SYSTEM WITH MULTIPLE CONNECTIONS
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Meodify | Plumbing Fixtures

=% ® & P17 3

Edit Connect Edit Pick Piping

Family Into | Work Plane = New

I Mode Work Plane | Placement
. E
" .
n

| Plumbing Fixtures : Sink - Service : 22"x19" - Public i

Fabrication | Layout

10.00 FU

TARGET: PLUMBING FIXTURE — SOURCE NOT REQUIRED (I.E. WASTE, FOR A VARIETY OF REASONS)

In all cases, the system is defined by the connector, the role the part plays in the system and
the defined Revit family category.

To create the system, you simply choose the system type from the ribbon. If a part has more
than one connection, such as with the sink, you may be prompted to select the connector and
system type (in this case, piping):

Create Piping System ? x

System type:

System name: Domestic Cold Water
Other

|| Open in System Editor

Cancel

You would also be prompted to specify a system name, which helps you identify the system in
the project.

Duct Systems Defined

Once you select the HVAC component that contains the duct connector, selecting the Duct
system causes the Create Duct System dialog to appear:
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Create Duct System ? *
System type: Supply Air e

System name: | Office 5 Supply Air

Open in System Editor

Corcel

When only option, such as Supply Air, is available, it's because the connector has a
preassigned system classification — in this case, Supply Air. If multiple Supply Air systems
are listed, it's because you may have more than one Supply Air duct system defined — but only
systems that are tied to the Supply Air classification can be used.

The only time you will see all system types appear is when the connector is set to Global or
Other.

Here’s an important note: NAME YOUR SYSTEM. This will help you clearly identify what the
target is servicing — such as the OFFICE 5 SUPPLY AIR system name.

Selecting Edit System will open the entire set of system tools. The tool appears on the Modify |
Duct Systems tab of the ribbon:

fication  Site Designer  Modify | Duct Systems

Design to Edit Select Divide
Fabrication System Equipment System
Fabrication System Tools

This tool allows you to review the properties, add/remove targets that define the system, and
select the Source Equipment:

oy || = G % X

Modify |Properties Add Remove Select Finish Cancel
to System| from System  Equipment Editing System Editing System

Select ¥ Properties Edit Duct System Mode
EDIT DUCT SYSTEM TAB

Keep in mind — you can select any target that has been defined to a system after it has been
defined, but you will get two context sensitive modify tabs:
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ication  Site Designer  Modify | Air Terminals = Duct Systems

] B 4

Edit Connect Air Terminal
Family Into on Duct
Mode Fabrication Layout

Modify Air Terminals will you get you the Edit Family, Fabrication and Layout and Analysis
tools, while Duct Systems will display the tools for editing the duct system.

Make sure you are selecting the right tab based on the changes you are making!

The Edit Duct System (or Edit System) tool, located on the Duct Systems tab, opens the
system up for editing. This tool allows you to:

o Review and set system properties such as the system name, image and comments that
can be used in a schedule, and edit the system Type, which controls the graphic
overrides, materials, calculations, identity data and rise drop symbols;

o Add other targets to the system (the system type must match);

e Remove targets from the system;

e Select the Source Equipment from a drop down list or by selecting the equipment family
in the model view;

o See the number of elements that are included in the system;

¢ Finish and Cancel editing the system — note that you HAVE to close this tool by
selecting one of the options before moving on to another task.
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Pipe Systems Defined

Similar to the duct systems, you select the equipment component that contains the pipe
connector, and selecting the system makes the Create Pipe System dialog appear:

Create Piping System ? ot

System type: Hydronic Supply e
=

System name: Hydronic Return

Sanitary

Dormestic Hot Water
Domestic Cold Water

Fire Protection Wet

Fire Protection Dry

Fire Protection Pre-Action
Fire Protection Other o
Other
Vent

In this case, the connector is set to global, so you can select any system type or classification.
Keep in mind that once the connector is set to a specific system classification, only system
types in the same classification can be used.

As with duct, make sure NAME YOUR SYSTEM to clearly identify what it is servicing.
Selecting Open in System Editor will open the entire set of system tools.

In some cases, if you have more than one connector assigned to the same system

classification, you will be prompted to select a connector — all unconnected connectors will
appear in the list (...get the connection???):

Select Connector: Centrifugal Purnp - Horizontal >

Connector 2 * Undefined - Round © 1 1;4 : Water;"@ther IJquud Out

Carce

Select the connector you wish to use, and then click OK.
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Leaving this option selected opens the Edit Piping Systems tab of the ribbon:

“, . [ ] =
s |5 || 68 | G=2 M Y ) ¢
Modify |Properties Add Remove Select Finish Cancel
to System| from System  Equipment Editing System Editing System
Select ¥ Properties Edit Piping System Mode

Edit Piping System

Properties X [} HVAC FIRST FLOOR X

&

Piping System: Hydronic Supply 1

Piping System
Hydronic Supply

v @Edit Type

E
Mechanical (o)

Number of Elements 1

System Equipment
System Name
Volume

119 Gallon

Hydronic Supply 1 —
10.4 gal L

Identity Data
Image
Comments

Properties help Apply

PIPE SYSTEM TAB

This tool allows you to:

e Review and set system properties such as the system name, image and comments that
can be used in a schedule, and edit the system Type, which controls the graphic
overrides, materials, calculations, fluid mechanical properties, identity data and rise drop
symbols;

o Add other targets to the system (the system type must match);

¢ Remove targets from the system;

e Select the Source Equipment from a drop down list or by selecting the equipment family
in the model view;

o See the number of elements that are included in the system;

Finish and Cancel editing the system — note that you HAVE to close this tool by
selecting one of the options before moving on to another task.
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Keep in mind — you can select any target that has been defined to a system after it has been

defined, but you will get two modify tabs:

ification  Site Designer  Modify | Mechanical Equipment = Piping Systems

=) - (1

Edit esi Analytical ~ Connect Power
Family Connections Into
Mode Fabrication Create Layout Create Systems

Modify Mechanical Equipment will you get you the Edit Family, Fabrication, Create, Layout
and additional Create Systems tools (if additional connections are available), while the Piping

Systems tab will display to the right:

B [ ! :ﬂ 1
[% i System Selector: "/

Modify| | Properties & Hydronic Supply 1 v Edit

Select Properties System Tools

I{:\y |{:\“
< =

Select  Disconnect

System Equipment Equipment

Make sure you are selecting the right tab based on the changes you are making!
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Leveraging Systems for Sizing and Analysis

The key to understanding how to use Revit for duct and pipe sizing and analysis begins by
understanding how the connectors embedded in MEP families work. When the connector is not
properly defined, the system tools are ineffective. Understanding items such as flow direction,
system settings and associated parameters help the tools work smoothly in a project.

The Connector Rules!

The MEP connector is what separates MEP families from architectural and structural families.
The connector is used to create a starting (or ending) point of a system. Connectors use a
combination of predefined parameters, based on the part type, that setup information for the
sizing and analysis tools. While the connectors each have specific settings, you need to
understand a few rules first.

Flow Settings

In order to understand the best practices for connectors in Revit, you need to understand how
flow is handled. Flow is explained as the movement of air, fluid or power between a source and
target.

Flow direction, a parameter that is assign to a connector, is critical, but may be counterintuitive
to how we think. For example, the suction connection on a pump is considered an “in”
connection, while the discharge connection is out. In this case, the source (pump) is both a
target and source, since it receives fluid and also provides it to other devices. But if you are
connecting a pipe to a target, such as a spray nozzle, the flow direction remains as “in”, since it
is a target of the source. The fluid is not flowing out of the nozzle, but instead is in to the nozzle

from the pump.
Here’s another example from an air system. If you are designing an air handling system, the

source equipment is providing air out to a target, while the target is receiving air into the
terminal or equipment:

FLOW in REVIT

Terminal Unit -
VAV, FCU, etc.
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Even though we think of air flowing out of the air terminal into the room, this is not how Revit
treats the interaction. Most system errors we have encountered have occurred were a result of
flow direction being mislabeled, so make sure you understand this behavior first.

Connector System Relationships/Associated Parameters

With all connectors, you have a couple of options. You can predefine a system classification,
such as supply air, domestic cold water, or balanced power. In some cases, a global or other
option will be available. While it's a best practice to use a predefined system, you may have
some parts that are used across several system types. When a connector, such as a pipe or
duct connector is assigned as global, the initial connection defines the system classification.

Example: If you select the duct tool, and then set the system to Supply air, if the connector is set
to global, then the system is defined as supply air. You could use the same family again,
selecting Return air as the system — when you select the connector, the system will be assigned
as return air.

The scenario for using a global connection is when you are NOT performing air flow calculations
in a Revit model. Since the connector is global, some settings, such as loss method, loss
coefficient, and more cannot be used, since these are specifically related to the connector in the
part.

The way to check this? Review the properties of the part — if there is an associate parameter
icon next to the parameter, the data can be exposed and edited in the Revit project file:

Mechanical 2
Flow Factor 0.000000
Loss Coefficient 0.000000 Non-associative parameters
Flow Configuration Preset > — can only be changed by
Flow Direction In editing the family
Systemn Classification Supply Air
Loss Method Specific Loss

Mechanical - Flow T Associative parameters — can
Pressure Drop 0.0563 in-wg E be changed by editing the family
Flow S00.00 CEM C or editing the instance/type

"""" value in a project
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Understanding Connector Types

The connector is always defined in a family, and includes several properties that must be
correctly defined in order for a system to work correctly.

Let’s examine the main connector types:

The Duct Connector

Properties x
Connector Element (1) ~ N
Dimensions H .
Shape Rectangular A /0’1:6 +
0 = P
1" 0 = q‘
Loss Coefficient 0.000000
Flow Configuration Preset
Flow Direction Out
System Classification Return Air
Loss Method * \.
Mechanical - Flow ‘\0:5\
Pressure Drop = \g\e
Flow =
dentity Data
Utility ‘0
Connector Description
Properties help Apph /

The duct connector is assigned by system classification first, such as Supply, Return and
Exhaust air. It can also be set to Other Air or Global (which includes the same parameters as
the first three, but is not calculated in a model). Other Air allows any system classification to be
associated with the duct connector — but once it is set, it cannot be changed to a different
system classification — only a different type within that system classification.

One note about connectors — if the system classification is set to global or other, Revit will use
the last system type that was added in the model, as the default type, when the Add Duct grip is
used to place a duct. Always check your system type first on your connector first when using the
grip — or use the Add Duct tool from the ribbon, and select the system type you want to use prior
to placing the duct.

Duct connectors can be defined as rectangular, round or oval shapes.

Duct connections can be linked together, such as those in a terminal unit.

The connection includes built in parameters for the following mechanical properties:
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Connector Element (1)

Dimensions
Shape

o d

Rectangular

Height

Width

Diameter

Mechanical
Flow Factor

Loss Coefficient

Flow Configuration

Flow Direction

Systemn Classification

Supply Air

Loss Method

Specific Loss

Mechanical - Flow
Pressure Drop

0 (ER2
0.0563 in-wg

Flow 500.00 CFM =
|dentity Data &
Utility ]

Connector Description

o Flow Configuration — Select from three values — Preset, System and Calculated, for
measuring airflow in duct sizing

¢ Flow Factor — this percentage of system flow is used when the flow configuration is set

to System.

e Loss Coefficient — value becomes active when the loss method is set to Coefficient.

¢ Flow direction — sets the flow direction relative to the connector — In, Out and

Bidirectional

¢ System Classification — default system values for supply/return/exhaust/other/global,

or fitting depending on family type

e Pressure Drop — value becomes active when the loss method is set to Specific Loss
¢ Flow — default value assigned to the connector for air flow, and is included in the system

properties.
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The Pipe Connector

R

Connector Element (1) ~ Edit Type
Dimensions H]
Radius 0 05/8" =
Mechanical H]
K Coefficient 0.000000
Flow Factor 0.000000
Flow Configuration Calculated
Flow Direction Out
Loss Method Mot Defined
Allow Slope Adjustments O
System Classification Global
Mechanical - Flow
Flow :0.000 GPM
Pressure Drop 10,000 psi

|dentity Data A
Utility H il
Connector Description {Water/Other Liquid Out D

Properties help Apply

Changing the connector can change the available properties:

£

ECDnnectanlement (1) | CE Boit lype
Dirnensions A
Radius 0' 0 5/8" =
Mechanical ]
K Coefficient 0.000000
Flow Factor 0.000000
Flow Configuration Calculated
Flow Direction Out
Laoss Method Mot Defined
Allow Slope Adjustments | L.!
System Classification Sanitary
Mechanical - Flow 8
Frdure Units 0.000000
Flow 0.000 GPM i
Pressure Drop 0.000 psi

SANITARY PIPE CONNECTION

Page 20



’\ AUTODESK
AUNI\/ERSITY

Connector Element (1) w | HeE

>

Dimensions

| Connector Element (1) L
ELCTidrircdr

» i

K Coefficient

Flow Factor
Flow Configuration Calculated
Flow Direction Out
Loss Method Mot Defined
Allow Slope Adjustrments [E=]
System Classification Hydronic Supply w
Mechanical - Flow 3
Flow 0.000 GPM
Pressure Drop 0.000 psi
Identity Data 5
Utility O
Connector Description Water/Other Liquid Cut

HYDRONIC SUPPLY PIPE CONNECTION

Pipe Fittings require their own connector:

Connector Element (1) e

Constraints
Angle :0.00°
Dimensions ]

e

(==}

Radius o

n

Mechanical A
Systemn Classification {Fitting ;

Using an incorrect system classification on a fitting can impact the correct behavior of the part,
such as not allowing the pipe to deflect in small angles, such as with mechanical joint
connections that flex when placed underground.

Pipe connections can also be linked to each other. This only occurs when the connector is set
to global, and works best with inline components such as valves. The system type, flow
direction and flow values are carried from one connector to the next in a family when they are
linked. Either connector in a family can be designate as the primary, which also establishes the
direction a part will be placed during layout. The primary connector should always be placed on
the X-Axis in a family, when defining fittings.
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The connection includes built in parameters for the following mechanical properties, which vary

based on the type of system classification and flow configuration:

Connector Element (1)

Dimensions
Radius

Mechanical
K Coefficient

Flow Factor

Flow Configuration

Fizture Units

Flow Direction

In

Loss Method

Specific Loss

Allow Slope Adjustments

&

Systern Classification

Domestic Cold Water

Mechanical - Flow
Fidure Units

F|l'.‘ W

Pressure Drop

Identity Data
Utility

Connector Description

e Radius — size of the connection — can be set to measure as diameter or radius
¢ K coefficient — value is used when loss method is set to K coefficient
Flow Factor — value is used with flow configuration is set to system, measures

percentage of system flow from connector

Flow Configuration — predefined values for calculated, preset, system and fixture units
form of measurement, for pipe sizing

Flow Direction - sets the flow direction relative to the connector — In, Out and
Bidirectional

Loss Method — measures pressure loss based on specific loss, K coefficient, or not
defined

Allow slope adjustments — toggle that allows connected pipe to include a non-
perpendicular connection

System Classification - default system values for domestic hot/cold water, sanitary
waste/vent, fire protection, hydronic, other global or fitting, depending on family type and
use

Fixture Units — used with sanitary, vent, and domestic water systems when the flow
configuration is set to fixture units

Flow — value measured as volume rate for fluids

Pressure Drop — calculated pressure drop based on settings defined for Mechanical
Settings for a project

Utility — toggle that defines a connection to a site utility, when exported as an ADSK file
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Sizing Tools in Revit

Systems are defined by a target (or multiple targets) but work best when associated with a
source. Revit includes several tools that can used to size pipe, duct and wiring. Prior to using
the sizing tools, there are a few rules you need to know about each tool.

Duct Sizing
Duct can be sized using two different methods — friction loss and/or velocity sizing.

HVAC Supply, return and exhaust systems are sized based on the combination of project
mechanical settings (air density, dynamic viscosity and calculation method for straight segment
pressure drop), duct system settings, duct properties, and connector properties.

To size a duct:

You must have the system defined between a target and source;

The connector properties must include the proper values;

The system type must have calculations enabled, and mechanical properties assigned;
The sizing tools do not work on an “other” duct system — it is designed to work only with
pressurized systems.

1. Once the settings are defined, select a duct in a run. You can also select an entire run
by placing your mouse over a duct, and then tapping the tab key (without moving the
mouse).

2. When the entire run is highlighted, you select with the left mouse button.

3. The Duct/Pipe Sizing tool will appear on the ribbon, Modify tab, Analysis panel:

Quantification  Site Designer  Modify | Multi-Select = Duct Systems =~

— / -2 —

&I]IJ LI = EC?; %‘? I@-ﬂ @_]4- ?
Designto  Routing Justify Change Reapply Add Add Filter
Fabrication Solutions Type Type Insulation Lining
Fabrication Layout Edit Duct Insulation Duct Lining Selec

| g
- 3 |
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4. The Duct Sizing dialog will appear, if duct is selected:

Sizing Method

Velocity ~| [1000FPM

{®) Only () And O or

0.10 in-wg/100ft

Constraints
Branch Sizing:
Calculated Size Only e
[ ] Restrict Height: 95"
] Restrict Width: 96"
QK Cancel Help

5. The dialog allows you to select the sizing method and default value. It also allows you
to choose between one method, both methods, and an “or” option for either type.

6. Constraints place limits on branch sizing, allowing you to choose between the
calculated size only, matching the connector’s assigned size, or the larger of the
connector size and calculated value:

Constraints

Branch Sizing:
Calculated Size Onhy

Match Connector Size
Larger of Connector and Calculated

7. You can also restrict sizing to a specified value that sets the absolute limit of a duct
height and width size.

Pipe Sizing
Pipe can also be sized using two different methods — friction loss and/or velocity sizing.

Domestic Cold Water systems which include fixture units are converted to flow (gpm/Ips, etc.)
using a general conversion method based on the 2006 International Plumbing Code, Table
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E103.3. You must specify a flow conversion method in a pipe system’s type properties, as we
covered earlier. This can be set to predominately flush valve or flush tank toilets.

To size a pipe:

4.

You must have the system defined between a target and source;

The connector properties must include the proper values;

The system type must have calculations enabled, and fluid mechanical properties
assigned;

The sizing tools do not work on a Sanitary (gravity) pipe system — it is designed to work
only with pressurized systems, however, the pipe will track the assigned flow/fixture units
that are associated with the piping connected to the system.

Once the settings are defined, select a pipe in a run. You can also select an entire run
by placing your mouse over a pipe, and then tapping the tab key (without moving the
mouse).

When the entire run is highlighted, you select with the left mouse button.

The Duct/Pipe Sizing tool will appear on the ribbon, Modify tab, Analysis panel:

inage  Add Ins  Quantification  Site Designer  Modify | Multi-Select = Piping Systems

=" [ [C@J i k- P e

f . Designto  Analytical | Duct/Pipe | Filter

Fabrication Connections Sizing 0% Edit

Measure Create Fabrication Create Analysis Selection

The Pipe Sizing dialog will appear, if pipe is selected:
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Pipe Sizing x
Sizing Methed
Velocity | |4FPS

(®) Oy () And i0r
2.50 FT/100f

Constrairts

Branch Sizing:
Calculated Size Only e

[ | Restrict Size: g

Carcel Help

5. The dialog allows you to select the sizing method and default value. It also allows you
to choose between one method, both methods, and an “or” option for either type.

6. Constraints place limits on branch sizing, allowing you to choose between the
calculated size only, matching the connector’s assigned size, or the larger of the
connector size and calculated value:

Constraints

Branch Sizing:
Calculated Size Onhy

Match Connector Size
Larger of Connector and Calculated

7. You can also restrict sizing to a specified value that sets the absolute limit of a pipe
size.
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References:

Since the amount of detail needed to cover all aspects of pipe sizing is more in depth that we
have time to cover in the lab, follow this link for the full reference of pipe sizing from this link:

https://help.autodesk.com/view/RVT/2019/ENU/?quid=GUID-E1121308-E1E5-4AF1-B2FA-
913CBD35F656

Piping pressure drop calculation methods are located here:

https://help.autodesk.com/view/RVT/2019/ENU/?gquid=GUID-B3A3BB94-5223-4318-8DB4-
E1CDE85C62E0

For duct sizing, you can find more information here:

https://help.autodesk.com/view/RVT/2019/ENU/?quid=GUID-EFD12EAC-F54F-4C13-9E0QA-
7901CFE644C0
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Analytical Pipe Connections

Revit now includes an analytical pipe connection, which creates a system relationship to a pipe
without having to draw the smaller diameter piping in a model. For example, you may have
several VAV boxes, fan coil units, plumbing fixtures and other devices with piping connections.
But modeling all of the valves, accessories and piping adds to much detail to the project
deliverable.

The Analytical Connection tool appears when a component, such as a fan coil unit, has a pipe
connection included:

dd-Ins  Quantification  Site Designer  Modify | Mechanical Equipment )~

(&5 B -

D:D Edit Analytical Connect Duct Power Piping
=R Family Connections Into
Create Mode Fabrication Create Layout Create Systems
Cooling
550 VA
120V Qdt In
#1  SIE"5/8"
F &&

Out

When the user selects the tool, they are prompted to select a pipe that is defined using the
same system type. A graphical connection is made:
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The pipe connector flow and pressure properties are carried in the graphical line, and the

attached pipe also reflects the flow added to the pipe:

Modify | Analytical Pipe Connections

Properties X [ HVAC FIRST FLOOR X
]r.____ Analytical Pipe Connections =
) [4 Default
Analytical Pipe Connections (1) < #Edit Type
System Name Hydronic Supply 2 L
System Abbreviation
Mechanical - Flow
Critical Path
Flow 10.000 GPM
Identity Data
Comments
Phasing
Phase Created New Construction v
Properties help Apply
Project Browser - BES227181-L-MEP-Analysis.rvt x
+ Lighting Fixtures Lo,

= Mechanical Equipment
+ Air Handling Unit - Split System - Vertical

ANALYTICAL CONNECTION
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Modify | Pipes Diameter: E ) Offset:
Properties X [ HVAC FIRST FLOOR X
Pipe pes e _
Chilled Water
Pipes (1) ~ #Edit Type
Mechanical - Flow ‘A
Additional Flow 0.000 GPM
Flow 10.000 GPM
Reynolds Number 6590.873092
Relative Roughness 0.000587
Flow State Turbulent
Friction Factor 0.035318
Velocity 043 FPS
Friction 0.0404 FT/100ft v
Properties help Apply
Project Browser - BES227181-L-MEP-Analysis.rvt x
+ Lighting Fixtures L]

= Mechanical Equipment
+  Air Handling Unit - Split System - Vertical
PIPE PROPERTIES AFTER CONNECTION

Using this new feature can help reduce modeling time while helping to clearly indicate the
connection between equipment and pipe.
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Key Tips and Benefits

Systems provide greater benefits that sizing duct/pipe or tracking flow/pressure values. Systems
can help you select items easily, and can also be used to help quickly create groups. You can
also control object display in a view using the Filter tool using a system, and can associate data
from system objects with spaces. We will wrap this session up by taking a quick look at
leveraging the systems for these actions.

Selecting Systems

If you've worked with AutoCAD or Revit for a while, you have an idea of how items are selected.
Left mouse click selections are common, along with crossing and selection windows. Revit has
had a selection method that takes you beyond the left mouse click to a multiple object selection
method that doesn’t require dragging a mouse across the screen — but it can take a little
practice.

The TAB selection method is accomplished by hovering your cursor over an object, and then
tapping the TAB key to cycle through selection options. When using this over a wall, the
program will start by highlighting the first object the cursor is placed over. A second tab
highlights all of the connected walls, creating a great selection set for adding a roof or slab.

TAB selection works the same way with MEP systems. The first TAB highlights the MEP object,
then cycles through the connected devices. Here’s the best part — if you defined your systems
prior to adding duct, pipe or wire, the second TAB highlights all devices connected in a system
or circuit. Continuing to press the TAB key will cycle through higher level systems, systems
associated with additional connectors in a model, and previews for duct, pipe and wire layouts
that can be generated by the system settings.

Here are some examples of tab-selected systems:

= Gl

PIPING SYSTEM WITH ROUTED PIPE
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i

]
e~
|-| l’
]
u

| Piping Systems : Piping System : Hydronic Supply 2

PIPING SYSTEM WITH UNCONNECTED PIPE

e B | B

I {1 11 2]

PARTIAL TAB SELECTION OF DUCT SYSTEM

Leveraging Systems for View Filters

A key benefit for defined systems in a Revit model includes the ability to control the visibility of
associated objects by the system definition. A view filter applies a series of rules based on
system properties, and allows you to control the visibility of duct, pipe and electrical items.

To use the filter, open the tool from the View tab, Graphics panel, Filters tool:
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Ly Fr—3! = Sl ooo
5| [ @ = " 2 B
Modify View _ Visibilityq Filters { Thin Cut Render Render iD &
Templates  Graphics Lines Profile in Cloud Gallery | View

Select « | Graphics |

The Filters dialog appears:

Filters X
Filters Categories vl
|- Rule-based Filters Select one or more categories to be induded in the AND (All rules must be true) ~ | AddRule | I Add Set l
Domestic filter. Parameters common to these categories will
Domestic Cold Water be available for defining filter rules. System Classification v | contai.. ¥ | supply v | ==
Domestic Hot Water

Hydronic
Intenior
Mechanical - Exhaust

Filter list: <multiple=>

Mechanical - Return [ Hide un-checked categories
el A SHpRHY: [] Curtain Panels A
Sanitary

[] Curtain Systems

[] Curtain Wall Mullions
[] Data Devices

[ Detail ltems

] Doors

W Duct Accessories
W Duct Fittings

¥ Duet Insulations

T A,

i O T T Check Al Check None

How do | create and use view filters? II Cancel Apply
The dialog includes three main areas:
Filters — defines rule or selection based filters;
Categories — defines what objects the filter will be applied to;
Filter Rules — defines the rule based on the Revit tool, and what criteria define the rule.

Vent
Selection Filters

There are two types of filters — rule-based and selection filters.

Rule-based filters can be defined by selecting an existing filter and duplicating it, or by creating
a new filter.

To base a rule on a system type, select one of the existing examples, such as Mechanical —
Supply. Right click and select Duplicate.
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Filters Categories
[=]- Rule-based Filters Select one ar more
Domestic induded in the filte:
) comman to these o
Domestic Cold W... available for definir
Domestic Hot Wa...
Hydronic Filter list: | <show ;
Interor [ ] Hide un-chedket

Mechanical - Bxha... : :
Mechanical - Ret... (] Air Temin
Mechanical - Sup. [ Anahtical
Sanitany Duplicate

Vert
Selection Fiters

Rename

Delete
[ T Ayt

Once the new filter is defined, you can rename it, such as HVAC Supply — Makeup Air.

The advantage to duplicating an existing filter is that the categories and filter rules are already
defined, so it’s easier to modify. Review the categories, where specific duct categories are
selected, and then review the rule.

Selecting System Type changes the rule to match the type, which is the most likely item to be
modified by a user. Select the rule and choose between the following options:

System Type ¥ equals ¥~

iequals

does not equal
contains

does not contain
begins with

does not begin with
ends with

does not end with

When you select an item such as equals, you can then select the list of available system
types, where the System Type must exactly match these criteria:
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Cilkae Nlae
AND (All rules must be true) v Add Rule ‘ | Add Set
System Type > equals ~ v | ==

Exhaust Air

Exhaust Air - Fume Hood
Exhaust Air - Hazardous
Exhaust Air - Process
Exhaust Air - Vent
Return Air

Supply Air

Supply Air - Makeup

Supply Air - Outdoor Air

The filter tool allows as many rules to be applied, so it could be a good idea to add rules for
items such as System name, type mark and more.

AND (All rules must be true) ¥ I Add Rule l [ Add Set ]

System Type ¥ | equals %
Supply Air - Makeup v =

(none) s
IfcGUID A —

Keynote

Manufacturer
Mark —
Model

System Abbreviation

System Classification

System Mame

System Type

Type Comments
Type IfcGUID

Type Mark D
Type Name
URL

Cancel Apply

W

Filter rules can be based on AND/OR conditions:

AND (All rules must be true) v

AND (All rules must be true)
OR (Any rule may be true)
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¢ AND conditions mean that in order for a filter to be applied, all of the rules should meet
the requirements.

e OR conditions mean that any one of the rules can be applied — as long as one rule or
more rules are met, the filter rules are applied.

The other filter type includes a selection filter. This method works by letting the user select
items in a system, using the tab selection method (or any other selection method), and then
using the selection edit tool to create the filter.

For example, you can use tab selection to pick all of the items in a piping system. Once the
items are selection, click Manage, Selection and Edit. :

1-Ins  Quantification  Site Designer = Modify | Multi-Select = Piping Systems

| — I Y e

[B:J] [C\DJ Sﬁ:m ]E“ ? g Save

Designto  Analytical Duct/Pipe Filter
Fabrication Connections  Sizing &2 Edit

Create Fabrication Create Analysis Selection

The Edit Filters dialog appears, and you can choose to create a rule based filter or selection
filter. Click Selection Filter and then click New:
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Edit Filters bt

- Rule-based Filters
Domestic
Domestic Cold Water
Domestic Hot Water

Hydronic
Interior Rename...

New...

Edit...

Mechanical - Exhaust

Mechanical - Return Delete
Mechanical - Supply

Sanitary

Vent

Selection Filters

The Filter Name dialog appears, so add a name, such as Hydronic Piping System 1.

Filter Name *

Name: 'Hydronic Piping System 1

() Define rules
(O select

(®) Use current selection

You can then choose to define the rules, select a new group of items or use the current
selection.

If you select the last option, the filter will become available under selection filters, and can be

reused. When you return to the Filters dialog, the selection is available from the dialog, but the
categories and rules are set by the selection set.
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Filters

Filters

= Rule-based Filters
Domestic
Domestic Cold Water
Domestic Hot Water
Hydronic
Interior
Machanical - Exhaust
Mechanical - Retum
Meachanical - Supply
Sanitary
Vent

= Selection Filters

Hydronic Piping System 1

How do [ create and use view filters?

Categories

Select one or more categories to be included in the
filter. Parameters common to these categories will
be available for defining filter rules.

st: <multiple=>

Hide un-checked categories

[ Air Terminals ~
[ Analytical Spaces

[ Analytical Surfaces

[ Arsas

[ Assemblies

[ cable Tray Fittings

[] cable Trays

[ caliouts

[ casawork

Chedk All Chack Nona

Eltere fs i

oK

Cancel

Apply

Here’s where this gets fun — a quick way to select this group again, is to use the Selection,

Load tool to reselect the same items (you can also run this tool from the Manage tab):

Create

d-lns  Quantification  Site Designer

B 4

Fabrication Connections

Fabrication

Meodify | Multi-Select

Piping Systems

] r:.... [E | ? ‘h Save
¥ !
i , , &4 Load
Analytical ~ Duct/Pipe Filter \x
Sizing & Edit
Create Analysis Selection

It doesn’t matter what view you are in when you load the selection filter — the items will remain
highlighted, so changing to another view, such as a 3D view, will keep the items selected:
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IEDB Acchitecture  Structure  Steel  Systeme  Insert  Annotate  Analyze Collsborate View Manage Addins  Quantification  Site Designer  Modify | Multi Sefect

h g System Selector: @
Madify| |Properties| () Hydronic Supply 1 >

Piping Systems

Edit Select Disconnect
System Equipment Equipment
Select Properties System Tools

Modify | Multi-Select Activate Dimensions.

Properties X [ HVACFIRSTFLOOR [} PIPEFIRSTFLOOR = 3D Plumbing X
Piping Systermn =
Hydronic Supply
Piping System: Hydronic Supply 1 ~ ‘Edit Type
Mechanical i~
Number of Elements
Systern Equipment 119 Gallon
System Name Hydronic Supply 1
Volume 104 gal

Static Pressure

Mot Computed

Mechanical - Flow
Flow Not Computed P
Identity Data v A
Bropenies help Apply |-
Project Browser - BES227181-L-MEP-Analysis.rvt 3,
= Mechanical Lo )
= HVAC
= Floor Plans
HVAC FIRST FLOOR
LOWER ROOF
T/ FOOTING
+ 3D Views

+ Elevations (Building Elevation)

You can use these items with the copy or move commands, or edit the system, regardless of
where the original tab selection — based on the system — was defined.

BONUS TIP — Select any object that belongs to a system, such as a pipe or duct. Right click,
and choose the Hide in View > By Filter option:
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% 9;‘-‘ C 4
. . .

Cancel ' -

-~ -

Repeat [Hide by Filter] . 3

' . . Recent Commands »

Hide in View > Elements
Override Graphics in View » Category

\ N Create Similar £ o '

Edit Famnily

Select Previous

Select All Instances »
Delete

Find Referring Views

Zoom In Region
Zoom Qut (2x)
Zoom To Fit

Previous Pan/Zoom

Mext Pan/Zoom

Browsers »

~  Properties

The VG Filter tab will appear, and allow you turn anything associated with a filter related to that
object on or off. Deselecting the visible option will turn ALL connected pipe in the system off,
based on the categories associated with the filter, and the assigned rule:

Visibility/Graphic Overrides for 3D View: 3D Plurnbing x

Model Categories  Annotation Categories  Analytical Model Categories  Imported Categories  Filters  Revit Links

. Projection/5Surface Cut
Mame Visibility - - Halftone
Lines Patterns Transparen... Lines Patterns

Override... Override... Owerride...

You can also override other graphics settings for projection/surface, cut and half tone from this
tool (or the Override Graphics in View option).
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Using Systems with Groups

On some projects, systems can be repeated in several locations in a project. If you plan on
using a typical system as a copy for others, you should consider using the group tool first. But
there are a few rules you need to know before you get started.

1. When selecting items for a group using the tab selection method, the system must not
contain open systems, or unconnected devices or circuits.

******************************************************

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Autodesk Revit 2017
Error - cannot be ignored - 1Error, 1Warning

None of the selected elements can be grouped. The elements may already be
grouped or may be element types which are not allowed for grouping.

<< 1of2 »> Show More Info Expand ==

v o]

Select items that are well-connected, such as a completed duct system layout that
includes targets and sources, or a fully circuited system that includes wiring.

i

Y [ & [@
320 | Edit Ungroup Link
"¢ | Group

2. Once in a group, you can edit the group, and create systems/circuits for items which
belong in the group.

3. When using groups to copy to other locations in a project, when the items are
ungrouped, they are automatically assigned to a new system, provided the previous
items were well-connected.
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4. Creating connections to items in a group is limited. Since the group is contained as one
entity, you would need to edit the group in order to add, remove or edit items within a
system. However, you can connect to other connectors on a family (such as a duct or
pipe connector) that is not already assigned to another system.

5. When copying systems from level to level, these systems work best when non-hosted
target and source families are used, and the items placed in a group. When the items
are ungrouped, they will automatically be associated with the corresponding level. When
a hosted item is added to the group, the association to the original host is lost, but the
group can still be defined. You would have to re-associate the hosted families to their
new host (which is one of the reasons why we rarely use hosted MEP families!).

6. If you are planning to use the same layout in other projects, create a model group first.
Once the items are grouped, they can be saved as a Revit project file (.RVT). The group
can then be imported into another project. The rules apply — the group must be well-
connected! Use the Insert > Load as Group tool to bring the group into a new project.

The grouping tools are located on the Modify tab, when items are selected:

Modify | Multi-Select | Duct Systems

S - Designte | Justify | Filter =

Fabrication s Edit

sure

You can also create groups by selecting the tool from the Modify tab, Create panel, when items
are not selected:
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Modity
i-. ..:—w‘ H
|0 L
SE
‘ Cre_ate
Create Group =
Name: |
Group Type
(®) Model
() Detail
ok || Cand || Hep |

Once the tool is started, the Edit Group tool opens, allowing you to use window or pick
selections, but not tab selections for systems:

e B v X

Add |Remove Attach | Finish Cancel

Edit Group H
-

N/

STROOM

] St
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So it's best to select the items by the well-formed system first, and then use the group tool

BIG TIME NOTE: Groups can affect project performance if used in great numbers. Use the
groups instead to create duplicates, or move to different levels or areas of the project, and then
UNGROUP the items. This also makes sure the systems are correctly defined.

Tracking System Equipment Data with Spaces

Our last segment covers how data that is associated with system objects can be related to the
space associated with the room. In some cases, you may want to know what the airflow is for a
room, or the total lighting/receptacle load is for a space. Space objects in Revit can track this
data easily, so it's important to understand where you can review and control this data.

Duct System Data
When a duct is placed in a room where a Revit space object is located, the space will track the

flow assigned to the air terminal(s) as long as the air terminal falls within the vertical boundary of
the space. Here’'s an example from a section view showing this correctly defined:

Fropertier =

-
Spaes (1)

| Congtemnty 2 A

[ s timi A i T | ™

Limit Offset W : o=l S §

| Base Dtset oo )(( i

Electrical - Lighting s [ )—\_

Electrical - Loads =

(henensices ¥

e . RQOF L _ _ — _

| Specified Supply Aidfiow 0.00CFM

[ o 2 Speciied == == e
| St 0 A 000 CFM - 1 = - o
| spe n et Airflon

0,00 CFM

4
MEETING ROCM

Projed Drowier - 19650-MIP.AT *

Hexth - Elec
Seuth - Dlec

Note the properties of the space — even though the limit offset is set to be higher that the
terminals, the space is limited by the ceiling object. As long as the terminal is in contact with the
ceiling face on the side of the space, the space will track the airflow. But if the space upper limit
offset is not set high enough to intersect the air terminals, the airflow will not be included:
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Fropedies
.
R
Spaces (1)
(Constraints — . kS
Ueperins

Limt Cetset
Baze Offset

Electrical - Lighting

Electrical - Loads

Dimensians

Mechanical - Flow
Specihied Supply Aflow

urn Airflow

Specved Exhat Al

Project Buwrier - 196531 MER.ret
HNaorth - Elec

Sruith - Flar

T 0212
LY

000 CFAM
Specitied

Q.00 CFM

0.00 CFM

MEETING ROOM

»oa e w

RC

| i — _ N _ )
A ]
[/
)OF

-

The calculated value will be populated after the duct sizing tool is used. You can then create a
space schedule that tracks the actual supply airflow per room.

Conclusions

Understanding how to leverage systems within your project can significantly improve the quality
of your design. Learning how to account for these tasks to improve the project quality isn’'t as
complicated as it seems, as long as you understand the ground rules and benefits.
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